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QuickBooks 2008 has a new installation routine and a new QuickBooks Database Server 
Manager to assist users in opening and managing company data files.  
 
This guide is designed to support users installing QuickBooks: Pro or Premier 2008 in a 
networked environment, and it also covers installation on a single, stand-alone computer 
(as there are options to later convert such an installation into a networked installation). 
 
 
 
 

http://www.quickbooksenterprise.com/


Contents 
Introduction......................................................................................................................... 3 
Terms Used in This Guide .................................................................................................. 3 
Standard Install ................................................................................................................... 5 

Step 1: Choose “Guided Install” ................................................................................. 5 
Step 2: Choose “One Computer” Option .................................................................... 5 

Network Installs .................................................................................................................. 7 
Guided Install for Networks................................................................................................ 7 

Step 1: Choose “Guided Install” ..................................................................................... 7 
Step 2: Choose “More Than One Computer” Option ..................................................... 7 
Step 3: Choose from Three Options................................................................................ 8 

Step 3-A: Install QuickBooks with Company File Server.......................................... 9 
Step 3-B: Install QuickBooks Only .......................................................................... 10 
Step 3-C: Install QuickBooks Company File Server Only ....................................... 11 

Expert Install for Networks............................................................................................... 12 
Step 1: Choose “Expert Install” .................................................................................... 12 
Step 2: Choose from Three Options.............................................................................. 12 

Step 2-A: Install Multi-User Host: QuickBooks with Company File Server ........... 13 
Step 2-B: Standard Install of QuickBooks Only....................................................... 14 
Step 2-C: Install QuickBooks Company File Server Only ....................................... 15 

Notes on Google Desktop Search ..................................................................................... 16 
Installation Decision Can Affect Performance ............................................................. 16 
Background................................................................................................................... 16 
Benefits ......................................................................................................................... 16 
Drawbacks..................................................................................................................... 17 
Google Marketing Tools ............................................................................................... 17 

Appendix A: QuickBooks Database Server Manager ...................................................... 18 
The Manager Dialog Box.............................................................................................. 18 
Scan Folders.................................................................................................................. 18 
Monitored Drives .......................................................................................................... 19 
Database Server ............................................................................................................ 20 
Updates ......................................................................................................................... 20 

Appendix B: Converting a Standard Install into a Hosting, Multi-User Installation........ 22 
Enabling the Multi-User Host....................................................................................... 22 

Additional Steps Required ........................................................................................ 22 
Appendix C: How QuickBooks 2007 Manages Files ....................................................... 24 

Three Important QuickBooks Elements........................................................................ 24 
Importance of the Database Server ............................................................................... 24 
“ND” Files: Keeping Company File Locations Straight............................................... 24 
Mapped Drives.............................................................................................................. 25 

Copying Company Files onto Mapped Drives.......................................................... 25 
Background............................................................................................................... 25 
Solving for Mapped Drives....................................................................................... 26 

Permissions Levels........................................................................................................ 28 
Logged in until Logged Off ...................................................................................... 28 

Appendix D: Staying Current ........................................................................................... 29 
 

QuickBooks 2008 Network Installation Guide 2



Introduction 
 
Following are step-by-step installation instructions for QuickBooks: Pro 2008 and 
QuickBooks: Premier 2008. Users installing QuickBooks Enterprise Solutions should 
refer to guides specific for that product.  
 
When users install QuickBooks 2008, the installation screens will guide them through 
installations for either a single, stand-alone machine or for an environment where two or 
more machines are networked.  
 
While the primary reason for this guide is to help users in a networked environment, 
many users plan on using QuickBooks on a stand-alone machine. Therefore we first turn 
to the following section, “Simple Install,” to cover installation for a single, stand-alone 
machine. The section “Network Install” begins on page 7. 
 

Terms Used in This Guide 
 
The following terms are used in this guide. Refer to this section if you have a question as 
to what a particular term means.  
 
Hosting. This refers to the ability of a computer to share QuickBooks Company Files 
with other computers. The hosting ability is managed by the QuickBooks Database 
Server Manager. 
 
Multi-user Installation. As another description of a network installation, Intuit 
sometimes uses the term Multi-user Installation because often (but not always) the 
network installation is in support of multiple users of the QuickBooks company files. But 
this term is meant to apply as well if there is only one user accessing files across a 
network. 
 
QuickBooks Application. This is the main software program that you use to do work. 
But it does not work alone. Behind the scenes the QuickBooks application completes its 
tasks by sending commands to a database server to read or write data to a company file.1

 
QuickBooks Company File. This is the database file itself, containing all the financial 
information for one company.  
 
QuickBooks Company File Server. This is an application that enables QuickBooks to 
read and write to QuickBooks Company Files. We also use the term QuickBooks 
Database Server. 
 

                                                 
1  In contrast, in QuickBooks 2007 and earlier, the QuickBooks application read or wrote to the data file 
directly. There was no database server. 
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QuickBooks Database. Starting with QuickBooks 2008, QuickBooks: Pro and Premier 
began using a database approach to managing QuickBooks Company Files. Therefore a 
QuickBooks Company File is also a QuickBooks database file.  
 
QuickBooks Database Server. This is an application that enables QuickBooks to read 
and write to QuickBooks Company Files. We may also use the term QuickBooks 
Company File Server. 
 
QuickBooks Database Server Manager. This application, new in QuickBooks 2008, 
helps the user deal with some of the chores required for maintaining the QuickBooks 
Database Server. For more information, see Appendix A: QuickBooks Database Server 
Manager. 
 
Server Only Installation. In some firms or company, QuickBooks Company Files are 
hosted on a server but the QuickBooks application is not installed on the server. With 
QuickBooks 2008, users can now install only the QuickBooks Company File Server (or 
QuickBooks Database Server). For more information, see Appendix A: QuickBooks 
Database Server Manager. 
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Standard Install 
 
The Standard Install is for the single, stand-alone machine. This option covers the 
scenario in which the user runs QuickBooks on one machine and keeps all QuickBooks 
company files on that same machine. Intuit uses the term “Standard Install” in part 
because a majority of QuickBooks users continue to use QuickBooks on a single 
machine. 
 

Step 1: Choose “Guided Install” 
 
The installation begins with the welcome screen shown in Figure A. 
 

 
 
Figure A. Welcome Screen 
 
From the Welcome Screen, choose the Guided Install option. (We recommend the 
Expert Install for professionals whose business includes installing QuickBooks for their 
clients or for IT administrators. Otherwise we recommend the Guided Install.) 
 
 

Step 2: Choose “One Computer” Option 
 
The next dialog box asks the user how he or she will be using the QuickBooks software. 
See Figure B. 
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Figure B. “How Will You Use QuickBooks?” 
 
From the two options shown, choose One Computer. This option starts the installation 
for the Standard Install. 
 

Note: The Standard Install disables the database server for hosting company 
files for access by the QuickBooks application running on other machines. To 
enable the database server following a Standard Install, users can turn on 
Hosting from the File > Utilities menu. For more information, see Appendix B. 
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Network Installs 
 
This section covers options for networked environments, in which QuickBooks files will 
be shared across two or more computers. Users installing for a network can choose to 
follow either a Guided Install or an Expert Install. We will cover both kinds of 
installations. Both provide the same options and the same results. 
 
The Guided Install provides a series of interview questions to assist the user. The Expert 
Install is more direct and is a bit more technical in its descriptions. If you are uncertain 
what kind of network implementation to select, we recommend you start with the Guided 
Install. 
 

Guided Install for Networks 
 

Step 1: Choose “Guided Install” 
 
The installation begins with the welcome screen shown in Figure A. 
 

 
 
Figure C. Welcome Screen 
 
From the Welcome Screen, choose the Guided Install option. 
 

Step 2: Choose “More Than One Computer” Option 
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The next dialog box asks the user how he or she will be using the QuickBooks software. 
See Figure D. 
 

 
 
Figure D. “How Will You Use QuickBooks?” 
 
From the two options shown, choose More Than One Computer. This calls up the next 
screen in the Installation Interview. 
 
 

Step 3: Choose from Three Options 
 
The next dialog box offers three choices as shown in Figure E.  
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Figure E. Installation Options 
 
The installation routine will set the first choice, Multi-User Host etc., as the default 
selection. We will cover all three of the options in turn. 
 

Note: See the reminder at the top of the screen. You will need to run the 
installation program on ALL computers that will be using the QuickBooks 
application or company files. 

 
We will discuss each of these three options in turn. 
 

Step 3-A: Install QuickBooks with Company File Server 
 
This first option is for when the user plans to run QuickBooks from the computer being 
installed, and the QuickBooks company files to be shared with other computers on the 
network. 
 
To install this option, make sure it has remained selected as the default (se Figure F) and 
click the Install Now button.  
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Figure F. Installing QuickBooks with Company File Server 
 

Step 3-B: Install QuickBooks Only 
 
The second option, Install QuickBooks Only, is for when users decide they actually 
want to work with a single computer after all. In this option, QuickBooks is installed but 
the Company File Server is not enabled. See Figure G. 
 

 
 
Figure G. Installing QuickBooks Only 
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To choose this option, select Install QuickBooks Only by clicking on the circle to the 
left. Then click the Install Now button. 
 

Note: This option is the same as the Standard Install described earlier in this 
guide. Note that the messaging in the installation routine refers to installing the 
QuickBooks program only. This is to help the user make the right choice. More 
accurately, the QuickBooks company file server has been installed but is not 
enabled. Therefore the computer cannot host company files for access by the 
QuickBooks application running on another machine. To enable the database 
server following a Standard Install (or QuickBooks Only Install), users can turn on 
Hosting from the File > Utilities menu. For more information, see Appendix B. 

 

Step 3-C: Install QuickBooks Company File Server Only 
 
The third option, Install QuickBooks Company File Server Only, is for networks 
where QuickBooks company files are maintained on a separate server, and users run 
QuickBooks from other machines to access the company files. See Figure H. 
 

 
 
Figure H. Installing QuickBooks Company File Server Only 
 
To choose the third option, select Install QuickBooks Company File Server Only by 
clicking on the circle to the left. Then click the Install Now button.  
 

Note: When you complete installation of the QuickBooks Company File Server, 
you will see the QuickBooks Database Server Manager dialog box. We discuss 
the program in Appendix A. 
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Expert Install for Networks 
 
The Expert Install option is designed for the professional who does multiple QuickBooks 
installations for clients or the IT administrator of a company or firm. It provides the same 
three options as the Guided Install discussed previously but gets to the options sooner for 
networks provides the same options  
 

Step 1: Choose “Expert Install” 
 
The installation begins with the welcome screen shown in Figure I. 
 

 
 
Figure I. Welcome Screen 
 
From the Welcome Screen, choose the Expert Install option. 
 

Step 2: Choose from Three Options 
 
The next dialog box offers three choices as shown in Figure J.  
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Figure J. Installation Options 
 
The installation routine will set the first choice, Multi-user Host etc., as the default 
selection.  
 

Note: See the reminder at the top of the screen. You will need to run the 
installation program on ALL computers that will be using the QuickBooks 
application or company files. 

 
We will discuss each of these three options in turn. 
 

Step 2-A: Install Multi-User Host: QuickBooks with Company File Server 
 
This first option is for when the expert installer wants the user to be able to run 
QuickBooks from the computer being installed, and the QuickBooks company files on 
that machine to be shared with other computers on the network. 
 
To install this option, make sure it has remained selected as the default (se Figure K) and 
click the Install Now button.  
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Figure K. Installing QuickBooks with Company File Server 
 

Step 2-B: Standard Install of QuickBooks Only 
 
The second option, Standard: Install QuickBooks Only, allows the expert installer to 
set QuickBooks to operate on a single computer and with the hosting capability disabled. 
In this option, QuickBooks is installed but the Company File Server is not enabled. See 
Figure L. 
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Figure L. Installing QuickBooks Only 
 
To choose this option, select Standard: Install QuickBooks Only by clicking on the 
circle to the left. Then click the Install Now button. 
 

Note: This option is the same as the Standard Install described earlier in this 
guide. Note that the messaging in the installation routine refers to installing the 
QuickBooks program only. More accurately, the QuickBooks Database File 
Server has been installed but is not enabled. Therefore the computer cannot host 
company files for access by the QuickBooks application running on another 
machine. To enable the database server following a Standard Install (or 
QuickBooks Only Install), the expert installer can turn on Hosting from the File > 
Utilities menu. For more information, see Appendix B. 

 

Step 2-C: Install QuickBooks Company File Server Only 
 
The third option, Install QuickBooks Company File Server Only, is for networks 
where QuickBooks company files are maintained on a separate server, and users run 
QuickBooks from other machines to access the company files. See Figure M. 
 

 
 
Figure M. Installing QuickBooks Company File Server Only 
 
To choose the third option, select Install QuickBooks Company File Server Only by 
clicking on the circle to the left. Then click the Install Now button.  
 

Note: When you complete installation of the QuickBooks Company File Server, 
you will see the QuickBooks Database Server Manager dialog box. We discuss 
the program in Appendix A. 
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Notes on Google Desktop Search 
 

Installation Decision Can Affect Performance 
 
At a later stage in the installation process, users are given an option to install Google 
Desktop Search. (See Figure N.) 
 

Caution: While there are benefits to this feature, installation can affect 
performance. We recommend QuickBooks users carefully weigh the pros and 
cons before making a decision about installation. 

 

 
 
Figure N. Google Desktop Installation Screen 
 

Background 
 
Part of this plug-in application will index the data in QuickBooks company files. Like the 
desktop search, this indexing process is done in the background, and when the indexing is 
done, the user can get complete keyword search results from QuickBooks transactions -- 
all using the superior search algorithms developed by Google. 
 
Indexing only occurs when a QuickBooks file is open, and only when QuickBooks is in 
single-user mode. Indexing will not occur when QuickBooks is in multi-user mode. 
 

Benefits 
 
This new feature will allow clients to search easily through their desktop contents, 
including the information in individual QuickBooks transactions. 
 
The great benefit for the small business owner is that this search approach is easier to use 
than the QuickBooks Find feature (which conducts a so-called “parametric” search). 
Another benefit is Google Desktop Search can combine a desktop search with the 
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QuickBooks search, so the user can see relevant QuickBooks transactions alongside 
Word documents and other items that include the keyword being searched. 
 

Drawbacks 
 
It is important for users to understand that while the indexing process occurs, system 
performance may be slower. We currently recommend at least one Gigabyte of free 
hard drive space for this feature. Actual size of the index file created will depend on the 
size of the QuickBooks Company File and amount of material stored on the machine. 
 

Note: Users who work with multiple QuickBooks Company Files – such users 
including QuickBooks ProAdvisors and other accounting practitioners – have 
additional reasons to consider carefully whether to install Google Desktop 
Search. Because such users often open many QuickBooks Company Files, 
performance is likely to become slower, as indexing will start for any new file they 
open. The overall index file created will also build with each new file as it is 
opened, so that this index file is likely to be larger for these users than a user 
with a single company file. 
 
Most users with multiple company files are adept at using the QuickBooks Find 
feature, which remains enabled (Edit > Find). 

 
Intuit understands the potential impact of these drawbacks and is researching the situation 
further. 
 

Google Marketing Tools 
 
Please note that any drawbacks related to Google Desktop Search do not relate to the 
several useful Google Marketing Tools being made available to users of QuickBooks 
2008. 
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Appendix A: QuickBooks Database Server Manager  
 
New to QuickBooks 2008 is a QuickBooks Database Server Manager.  
 

Note: For users of QuickBooks 2007 over a network, in QuickBooks 2008 the 
QuickBooks Database Server Manager replaces the QuickBooks Data File 
Scanning Utility that was used in QuickBooks 2007. 

 
Within this appendix, we use the term Manager as short-hand for QuickBooks 
Database Server Manager. 
 
The new Manager helps to manage the creation and maintenance of these ND files. 
(QuickBooks uses a location file, with the extension .ND, to keep track of where a 
QuickBooks company file is located for machines across the network. For every 
QuickBooks Company file, QuickBooks creates a companion file documenting the 
location of the QuickBooks company file. This location file has the extension .ND. A 
QuickBooks company file named MyBiz.QBW also has a companion file named 
MyBiz.ND. (For more on .ND files, see Appendix C.) 
 

The Manager Dialog Box 
 
Completing a server-only installation of QuickBooks 2008 also launches the QuickBooks 
Database Manager Application. (See Figure A-1.) You can also launch the QuickBooks 
Database Manager application later from the Start > Programs > QuickBooks > 
QuickBooks Database Server Manager link, and you should leave this tool running 
on the server and restart the application when you restart the server. Note that by 
default the Manager dialog box opens on the Scan Folders tab. 
 

Scan Folders 
 
The Scan Folders tab of the Manager dialog box lets you manage the folders to be 
checked by a manual scan. (See Figure A-1.) You can add or remove folders as needed. 
Once you have identified the folders to be scanned, press the Scan button. 
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Figure A-1. The Scan Folders Tab 
 
This tab will allows the user to save the folders that the user wants to scan on a regular 
basis. After users select the folders to be covered, they only need to press the Scan button 
in future efforts. 
 
Once folders have been scanned, you will also want to set up the program to monitor 
drives. 
 

Monitored Drives 
 
The Monitored Drives tab of the Manager allows you to identify the drives you select 
to ensure that other computers can open the QuickBooks company files that are created 
on, or copied or moved to, the current computer. See Figure A-2. 
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Figure A-2. The Monitored Drives Tab 
 
The software will identify available drives for you, and the only thing you need to do is to 
check those drives where QuickBooks company files may reside. 
 

Note: Once you check the drives in question, the Manager will monitor the drives 
automatically. You only need to intervene if the environment changes and you 
add or delete certain drives. 

 
The Manager will monitor all drives that are check-marked. 
 

Database Server 
 
The Database Server tab is shown in Figure A-3. This tab reports on the status of the 
database server. (Note: The Computer Name and IP Address have been fictionalized 
for this example.) 
 

 
 
Figure A-3. The Database Server Tab 
 
The tab also indicates which release of the Database Engine is currently being used.  

Updates 
 
The fourth and final tab on the Manager lets you know which version of the Manager you 
are using. The example in Figure A-4 shows version R1.2441.  
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Figure A-4. The Updates Tab 
 
At the bottom of the tab, a link, Check online for the latest version, lets you check for 
any updates to the Manager program.  
 
If the user identifies a more recent version, the Updates tab of the dialog box includes the 
step-by-step process for downloading and installing the update. 
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Appendix B: Converting a Standard Install into a 
Hosting, Multi-User Installation 
 
Any computer that is set up as a Standard Installation will not allow hosting of the 
QuickBooks company files to other machines across a network. However, users do have 
the option of converting the installation so it will allow the hosting, without having to 
reinstall the software. 
 

Caution: When hosting is enabled from a Standard Installation, users need to 
take extra steps to make sure that the QuickBooks Database Server tracks file 
locations accurately.  

 

Enabling the Multi-User Host 
 
In a Standard Install for a single-user computer, the database server is present but not yet 
enabled. (This may seem to contradict the installation screens, which say the Standard 
Install installs QuickBooks only, and not the server. More accurately, the Standard Install 
does not enable the database server.) 
 
You can enable Multi-User Hosting from the File pulldown menu, selecting Utilities, and 
then Host Multi-User Access. However, to start the Manager and make sure it operates 
in the background moving forward, there are a few manual steps currently required. 
 

Additional Steps Required 
 
More steps are required to make sure the hosting works properly.  
 

1. Navigate to C:\program files\common files\intuit\quickbooks or the current 
installed location for the QuickBooks application. 

2. Double-click the QBServerUtilityMgr.exe to get it started. The Manager dialog 
box will open as shown earlier in Figure A-1. 

3. If you believe you have existing QuickBooks company files without ND files, you 
can use the Scan Folders tab to scan the folders you designate. Or, you can 
confirm that the local hard drives are identified in the Monitor Drives tab (as in 
Figure A-2) and then close the Manager dialog box. Manager will then monitor 
the drives from this point forward all your local hard drives (until the computer is 
turned off or the admin logs out, of course). 

4. So the Manager will run in the background, you will need to make sure Manager 
will auto-start with windows. To do this, right-click on the file 
QBServerUtilityMgr.exe and then select Create Shortcut from the pop-up 
menu options. 

5. Once the shortcut has been created, right-click on it and then select Cut from the 
pop-up menu options. 
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6. Navigate to  
 
C:\Documents and Settings\All Users\Start Menu\Programs\Startup  
 
and right click the folder. Then select Paste from the pop-up menu to put the 
QBServerUtilityMgr.exe shortcut into the list of programs that will auto-start 
when Windows starts. 

 
Following these steps will not just enable Multi-User Hosting but also enable the 
QuickBooks Database Server Manager 
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Appendix C: How QuickBooks 2008 Manages Files  
 

Three Important QuickBooks Elements 
 
As an aid to helping users understand the database underpinnings of QuickBooks 2008,
we would like to conceptualize QuickBooks as containing three 
important elements. They are 
 

1. The QuickBooks Application. This is the main QuickBooks program, 
represented by the QuickBooks screens that you look at when you run 
QuickBooks and actually do work in a QuickBooks Company File.  Whenever 
you do anything in QuickBooks (running a report, creating an invoice, or adding 
transactions) the QuickBooks application needs to read or write data to the 
company file. It does this by sending commands to the QuickBooks Database 
Server.2 

2. The QuickBooks Database Server. This is a program that runs constantly along 
with QuickBooks and reads data from, and writes data to, the QuickBooks 
Company File. 

3. The QuickBooks Company File. This is the database file, containing all the 
financial information for one company. 

 

Importance of the Database Server  
 
To make sure that the company file is properly maintained and current, it should always 
be opened by a database server on the same machine. Otherwise there could be multiple 
versions of the company file, with data updated in one and not the other. 
 
With the proper installation of the database server we make sure that all computers that 
have company files stored on them also have a database server running on them in order 
to avoid this situation. 
 

“ND” Files: Keeping Company File Locations Straight 
 
Whenever the QuickBooks application tries to open a company file in a network setting, 
it needs to know which database server to use. Is the company file on the same machine 
from which the user runs the QuickBooks application? Or is the server on another 
machine? 
 

                                                 
2 Unlike pre-database QuickBooks, the application itself cannot actually update or read the data file 
directly. Rather, the QuickBooks application needs to update or read the data file through the database 
server. 
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For example, the user might be running QuickBooks on Computer A, and open a 
company file on Computer B, and so now Computer A needs to know the path to send 
commands to the database server running on computer B. 
 

Note: A company file must be opened by exactly one database server.  – You 
can never have two database servers trying to access the same company file, 
since they would both be reading and writing conflicting updates to the file.) 

 
In QuickBooks 2008, path information is stored in a file that’s created when 
each company file is created. This location file has an .ND extension. The “ND” stands 
for network descriptor. So, if Joe’s Plastics.QBW is the company file, when the user 
tries to open it, QuickBooks will look for a file called Joe’s Plastics.QBW.ND in the 
same directory so it knows where to send commands to the database server which is 
accessing Joe’s Plastics.QBW. 

 
Note: If the company file is on the same machine as QuickBooks, then 
QuickBooks will look for the ND file. If there is no ND file existing, QuickBooks 
will open the company file using the database server on that same machine. And 
QuickBooks will create an ND file which tells QuickBooks that this machine’s 
server is the one to use to address this company file in future. 

 

Mapped Drives 
 
This next section explains the need for the QuickBooks database server in the context of 
using mapped drives, to underscore why it is crucial to make sure the QuickBooks 
Database Server Manager is installed and operating properly. 
 
Without the QuickBooks Database Server Manager (which we will start calling 
Manager for convenience), the database server is unable to deal with company files 
copied onto mapped drives. A mapped drive is physically on a different computer and 
not on the actual machine where the accountant is sitting. Instead the path to the other 
computer is mapped to a drive letter as a convenience in moving and accessing files. 
Mapped drives often start at an F drive or a G drive, but can take any letter. 
 

Copying Company Files onto Mapped Drives 
 
In the absence of the Manager, the potential problem would exist whenever any new 
company file is brought in from outside and copied onto a mapped drive. The following 
discussion assumes an accounting office as its primary example. 
 

Background 
 
Many accounting offices maintain multiple company files on a central server. 
(QuickBooks should be installed on this central server using the QuickBooks Server 
Only Install.) 
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In this model, the setup would then include several workstations where one or more 
bookkeepers or accountants would actually sit and work on various QuickBooks 
Company Files as pulled from the central server. (QuickBooks should be installed on 
these workstations using the Multi-User Hosting Install.) 
 
Accountants in a networked office frequently get client company files and copy them on 
a mapped drive. 
 
What’s important is that the actual physical location is on the central server. Because this 
file location is not on the local machine, the QuickBooks Database Server is not able to 
create the ND file, and therefore cannot open the company file (since it doesn’t know 
where to find the database server it needs to use). 
 
Failure Notice. Without some additional process in place, were the accountant to copy 
the new company file onto a mapped drive, and then try to open the file, he or she would 
get a failure notice. 
 

Solving for Mapped Drives 
 
In QuickBooks 2008 the solution is for QuickBooks to install the separate QuickBooks 
Database Server Manager. The Manager helps keep track of company files with two 
separate operations: 
 

1. Scanning Folders. The Manager can be told to scan a hard drive, and whenever 
it finds a QBW or company file without an associated .ND file, it then auto-
creates the ND file. This is typically a one-time process that runs whenever you 
hit the Scan button on the Scan Folders tab. (See Figure D-1, which you will 
recognize from Appendix A.) 
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Figure D-1. The Scan Folders Tab 
 

2. Monitoring Drives. The Manager will constantly monitor a designated hard 
drive and auto-create ND files immediately, whenever a QuickBooks company 
file shows up. (See Figure D-2, again as repeated from Appendix A.) 

 

 
 
Figure D-2. The Monitored Drives Tab 
 

Note: The QuickBase Database Server Manager is the server running on the 
same computer as the company file. 

 
 
The Manager is installed as an “auto-run” application, to auto-start whenever the server 
is installed, for any QuickBooks installation except the Standard Install for a single, 
stand-alone computer.  
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Permissions Levels 
 
A significant drawback to this approach is that the Manager application needs the 
administrator’s permission level from Windows to create those ND files.  
 
The application gets the permission level from the permissions of the person who is 
logged into the machine when the application is running.  For this approach to work, the 
machine where the files are getting copied to (the server) will need to be running this 
application, and the administrator of the server will need to be logged in continuously. 
 

Logged in until Logged Off 
 
Note that logging in is not the same as responding to the Windows screen saver that 
requires a password.  When you log in after turning on your computer, you are logged in 
until you explicitly log off or turn off your machine – so you are still logged in the 
whole time even if a security screensaver comes up and requires a password.   
 
Intuit understands the potential impact of these drawbacks and is researching the situation 
further.  
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Note on Screenshots: In this Guide, some screenshots have been edited slightly for 
editorial presentation or space considerations. 
 

The information contained in this Installation Guide is intended to help QuickBooks users and 
their support personnel install and configure QuickBooks, and to determine where to keep 
QuickBooks company files on that network. This document reflects the views and 
understandings of Intuit at publication. Intuit cannot guarantee the accuracy of any 
information contained herein, and changes may have occurred after the date of publication. 

This white paper is for informational purposes only. INTUIT MAKES NO WARRANTIES, EXPRESS, 
IMPLIED OR STATUTORY, AS TO THE ACCURACY OR COMPLETENESS OF INFORMATION IN THIS 
DOCUMENT. 

© 2008 Intuit Inc. All rights reserved. Intuit, the Intuit logo, and QuickBooks, among 
others, are registered trademarks and/or registered service marks of Intuit Inc. in the 
United States and other countries. Other parties’ trademarks or service marks are the 
property of their respective owners and should be treated as such. Program terms and 
conditions, pricing, features and service options are subject to change without notice. 
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